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Änderungshistorie
Produkt-
version

Betriebsanleitung Änderungen Bemerkungen

2.09.xx BA00065S/04/DE/
01.12

– Originalbetriebsanleitung

2.09.xx BA00065S/04/DE/
02.13

Neu WirelessHART, NI Card, FFusb-Modem; MACTek-
Bluetooth-Modem, DTM installieren, Aktualisie-
rung DTM-Katalog, iDTM Austausch

Redaktionell USB Installation Verfahrensweise in Windows 7

Layout Neues CD

2.10.xx BA00065S/04/DE/
03.15

Layout Neues CMS

Neu HART über Rockwell Automation ControlLogix,
Kapitel PROFIBUS PA über Rockwell Automation
ControlLogix, Benutzerrollen, Überprüfen des Netz-
werks

2.10.xx BA00065S/04/DE/
04.15

Neue Kapitel und Ände-
rungen

HART über RSG45, Fieldgate SFG500 und Siemens
ET200M/iSP, PROFIBUS DP über PROFIBUS
Modem und WAGO Remote I/O, PROFIBUS DP
über PROCENTEC ProfiCore, Anlagenansicht,
SFG500 Fehlerinformationen

2.11.xx BA00065S/04/DE/
05.16

Neue Kapitel und Ände-
rungen

Einführung in FieldCare, Pepperl+Fuchs LB/FB
Remote I/O, HIMA, PROFINET - PROFIBUS Gate-
way, PBI-Plus, Heartbeat Verification, Heartbeat
Verification, I/O-Link Netzwerke, Schnittstelle zu
W@M

2.11.xx BA00065S/04/DE/
06.17

Trennung des Doku-
ments in Betriebsanlei-
tung und
Sonderdokumentation

Tutorial für FieldCare-Projekte SD01928S

2.12.xx BA00065S/04/DE/
07.17

Neue Produktversion
Änderungen in Kapitel
"Bedienung"

-

2.13.xx BA00065S/04/DE/
08.18

Neue Produktversion -

2.13.xx BA00065S/04/DE/
09.18

Änderungen Thema I/O-Link entfernt

2.14.xx BA00065S/04/DE/
10.19

Neue Produktversion IO-Link

2.15.xx BA00065S/04/DE/
11.20

Neue Produktversion • USB-Stick statt DVD
• Software-Lizenz-Management (SLM)

2.17.xx BA00065S/04/DE/
12.22

Neue Produktversion • FDI Package Support
• Sicherheits-Update

2.18.xx BA00065S/04/DE/
13.23

Neue Produktversion • Windows 11 Support
• Microsoft SQL Server 2022 Express
• Update FDI Package Support Endress+Hauser

und Fremdhersteller
• PROFINET CommDTM aktualisiert
• CDI CommDTM aktualisiert
• Flow Verification DTM aktualisiert
• Sicherheitsupdate von Komponenten
• Security-Handbuch SD03193S
• Katalog-Update, B&R Scanning und IO-Link ver-

bessert
• W@M-Funktionalität entfernt, da Abschaltung
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1  Hinweise zum Dokument

1.1  Dokumentfunktion
Diese Anleitung liefert alle Informationen, die für die Nutzung der Software benötigt wer-
den: Von der Produktbeschreibung, Installation und Bedienung über Systemintegration,
Betrieb, Diagnose und Störungsbehebung bis hin zu Software Updates und Entsorgung.

1.2  Verwendete Symbole

1.2.1  Warnhinweissymbole
GEFAHR

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu Tod oder schwerer Körperverletzung führen wird.

WARNUNG

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu Tod oder schwerer Körperverletzung führen kann.

VORSICHT

Dieser Hinweis macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht ver-
mieden wird, zu leichter oder mittelschwerer Körperverletzung führen kann.

HINWEIS

Dieser Hinweis enthält Informationen zu Vorgehensweisen und weiterführenden Sachver-
halten, die keine Körperverletzung nach sich ziehen.

1.2.2  Symbole für Informationstypen

Symbol Bedeutung

Erlaubt
Abläufe, Prozesse oder Handlungen, die erlaubt sind.

Zu bevorzugen
Abläufe, Prozesse oder Handlungen, die zu bevorzugen sind.

Verboten
Abläufe, Prozesse oder Handlungen, die verboten sind.

Tipp
Kennzeichnet zusätzliche Informationen.

Verweis auf Dokumentation

A Verweis auf Seite

Verweis auf Abbildung

Zu beachtender Hinweis oder einzelner Handlungsschritt

1. , 2. , 3.… Handlungsschritte

Ergebnis eines Handlungsschritts

Hilfe im Problemfall

Sichtkontrolle
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1.2.3  FieldCare Symbole

Symbol Bedeutung

Neues Projekt beginnen.

Vorhandenes Projekt öffnen.

Geöffnetes Projekt speichern.

Geöffnetes Projekt drucken.

Zwischenablage öffnen

DTM-Katalog anzeigen

Dokumentation für ausgewähltes Gerät oder Anlagenposition öffnen.

Inventarliste öffnen

Protokoll aktivieren

Neues Gerät zum Netzwerk hinzufügen.

Gerät vom Netzwerk entfernen.

Neue Netzwerk-Topologie erstellen mit Hilfe von Kommunikations DTM und Geräte-DTMs.

Vergleicht die Netzwerktypologie im Feld mit dem tatsächlich physikalischen Netzwerk und Geräte
werden in das bestehende Netzwerk hinzugefügt.

Scannt die vorkonfigurierte Topologie und zeigt denn Bericht mit den gescannten Geräteinformatio-
nen.

Zeigt an ob zum Gerät eine Verbindung besteht.

Informationen vom Gerät auf FieldCare transferieren.

Information von FieldCare auf das Gerät transferieren.

Gerätespezifische Funktionen für das ausgewählte Gerät.

Anlagenebene hinzufügen

Position hinzufügen

Anlagenebene entfernen

Position entfernen

Geräte-Checkliste öffnen um ausgewählte Geräte in der Anlage zu zeigen.

Ersetztes Gerät bestätigen.

Verbindung getrennt  1)
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Symbol Bedeutung

Kommunikation einrichten, Kommunikaionsbereitschaft  1)

Kommunikationskanal belegt oder Kommunikationsaktion abgebrochen. 1)

Verbunden  1)

Touchmodus anschalten

Touchmodus abschalten

1) Statusanzeige: Online/Offline-Statusanzeigen von Geräten in der Anlagen- und Netzwerkansicht

1.3  Kennzeichnung im Text

Hervorhebung Bedeutung Beispiel

Fettdruck Tasten, Schaltflächen, Programmsymbole, Register-
karten, Menüs, Befehle

Start → Programme → Endress+Hauser
Im Menü File die Option Print wählen.

1.4  Verwendete Akronyme

Akronyme Bedeutung

APL Advanced Physical Layer

CSV Comma Separated Value

DTM Device Type Manager (driver for devices)

FDI Field Device Integration

FDT Field Device Tool

HART Highway Addressable Remote Transducer

I/O Input / Output

IO-Link Markenname für ein Kommunikationssystem von intelligenten Sensoren und Aktuatoren

IODD Elektronische Gerätebeschreibung (IO Device Description)

IP Internetprotokoll

PROFIBUS Process Field Bus

PROFINET Process Field Network

SLM Software-Linzenz-Management

TCP Transmission Control Protocol

UDP User Datagram Protocol

URL Uniform Resource Locator

1.5  Dokumentation
FieldCare SFE500
• Getting Started KA01303S
• Tutorial für FieldCare Projekte SD01928S
• Technische Information TI00028S
• Security-Handbuch SD03193S
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1.6  Eingetragene Marken
PROFINET® ist eine eingetragene Marke der PROFIBUS Nutzorganisation e.V., Karlsruhe,
Deutschland.

PROFIBUS® ist eine eingetragene Marke der PROFIBUS Nutzorganisation e.V., Karlsruhe,
Deutschland.

IO-Link® ist ein eingetragenes Warenzeichen der IO-Link-Firmengemeinschaft/IO-Link
Community c/o PROFIBUS Nutzerorganisation e.V. (PNO) Karlsruhe/ Deutschland

FOUNDATIONTM Fieldbus ist das Markenzeichen der FieldComm Group, Austin, TX 78759,
USA.

HART®, WirelessHART® ist die eingetragene Marke der FieldComm Group, Austin, TX
78759, USA.

Ethernet/IP ist die eingetragene Marke von ODVA, Michigan USA.

Modbus® ist eine eingetragene Marke der Modbus Organization, Hopkinton, USA

Alle übrigen Marken- und Produktnamen sind Marken oder eingetragene Marken der
jeweiligen Unternehmen und Organisationen.
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2  Grundlegende Sicherheitshinweise

2.1  Anforderung an das Personal
Der physische und elektronische Zugang zu Feldgeräten, Netzwerken, Computern und Sys-
temen muss auf einen autorisierten Personenkreis begrenzt sein. Deshalb muss ein rollen-
basiertes Zugangssystem verwendet werden. Detaillierte Richtlinien und Prozesse sind zu
etablieren, um ausschließlich autorisierten Personen Zugang zum PC oder anderen Gerä-
ten zu ermöglichen.

2.2  Bestimmungsgemäße Verwendung
FieldCare ist ein FDT-basiertes (Field Device Tool) Werkzeug für das Plant Asset Manage-
ment, das je nach Version für die Geräteparametrierung, das Instrumentenmanagement
oder die Zustandsüberwachung verwendet werden kann. Durch die Verwendung ent-
sprechender DTM (Device Type Manager) unterstützt das Programm Feldgeräte und Sys-
temkomponenten unabhängig vom Kommunikationsprotokoll.

Es muss eine richtig konfigurierte Firewall verwendet werden, welche alle Daten blockiert,
die nicht den Sicherheitsvorgaben entsprechen. Um die Sicherheit weiter zu erhöhen, müs-
sen nicht verwendete Ports deaktiviert und eine Demilitarized Zone sowie ein Instrusion
Detection System verwendet werden. Ein organisierter und zeitnaher Patch Management
Prozess für alle Produkte wie z. B. Betriebssysteme, Internet Browser, Programme, Apps,
Datenbanken und Treiber soll angewendet werden. Ebenso ist eine Anti-Virus Software
auf dem PC zu verwenden. Hardware, Software, Firmware und andere elektronische
Inhalte sollen ausschließlich aus vertrauenswürdigen Quellen verwendet werden.

Auf die Verwendung von sicheren Kennwörtern für den elektronischen Zugang zu den
Programmen, z. B. für den PC, FieldCare, SQL Server und Feldgeräte wird hingewiesen:
• Mindestens 8 Zeichen verwenden
• Keinen Benutzernamen, Namen oder Firmennamen verwenden
• Darf kein vollständiges Wort enthalten
• Deutlich von früheren Kennwörtern unterscheiden
• Großbuchstabe, Kleinbuchstabe, Zahl und Symbol umfassen
• Muss regelmäßig geändert werden

Detaillierte Sicherheitshinweise: Siehe Security-Handbuch SD03193S
(www.endress.com/SFE500)

2.3  Produktsicherheit
DEP - Data Execution Prevention
DEP ist ein Sicherheitstool das hilft, Viren, Schaden und andere Sicherheitsbedrohungen
von dem Computer fern zu halten. Durch die Überwachung von Programmen kann DEP
helfen, den Computer zu schützen und sicherzustellen, dass die Systemspeichersicherheit
verwendet wird. Sobald ein Zugriff auf ein Programm gestartet wird, schließt DEP das Pro-
gramm.

DEP einstellen
1. Auf Windows-Taste → Pause-Taste → Erweiterte Systemeinstellungen → Erwei-

tert klicken.

2. Bei Aufforderung, das Administrator-Passwort eingeben.

3. Auf Leistung → Eigenschaften klicken.
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4. Auf die Registerkarte Datenausführungsverhinderung klicken und Wechseln zu
DEP für alle Programme und Dienstleistungen auswählen. Ist das Programm nicht
in der Liste, auf Hinzufügen klicken, das Programm auswählen und auf Öffnen kli-
cken.

5. Auf OK klicken.
 Das Dialogfenster "Systemeigenschaften" öffnet sich.

6. Auf OK klicken.

7. Den Computer neu starten, damit die Änderungen aktiv werden.

Nummer Erklärung Status

0 Immer Aus DEP ist für alle Prozesse ausgeschaltet.

1 Immer An DEP ist für alle Prozesse eingeschaltet.

2 Opt In DEP ist für wesentliche Windows-Programme und Dienstleistungen eingeschaltet,
Standardeinstellung.

3 Opt Out DEP wird für alle Prozesse, ausgeschlossen Programme und Dienstleistungen, ermög-
licht.

Technische Verbesserungen
Endress+Hauser behält sich das Recht vor, jederzeit und ohne vorherige Ankündigung
technische Verbesserungen an Software vorzunehmen. Wenn solche Verbesserungen kei-
nen Einfluss auf die Bedienung der Software haben, werden sie nicht dokumentiert. Falls
die Verbesserungen Einfluss auf die Bedienung haben, wird eine neue Version der
Betriebsanleitung erstellt und ausgegeben.

2.4  IT-Sicherheit
Eine Gewährleistung unsererseits ist nur gegeben, wenn das Produkt gemäß der Betriebs-
anleitung installiert und eingesetzt wird. Das Produkt verfügt über Sicherheitsmechanis-
men, um es gegen versehentliche Veränderung der Einstellungen zu schützen.

IT-Sicherheitsmaßnahmen gemäß dem Sicherheitsstandard des Betreibers, die das Produkt
und dessen Datentransfer zusätzlich schützen, sind vom Betreiber selbst zu implementie-
ren.
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3  Produktbeschreibung

3.1  Funktion der Software
Diese Betriebsanleitung beschreibt, wie mit FieldCare unter Verwendung von Modems,
Gateways und Remote I/O eine Verbindung zu HART-, PROFIBUS-, FOUNDATION Field-
bus, Modbus-, IO-Link und EtherNet/IP Geräten hergestellt werden kann.

3.1.1  Software-Lizenz-Management (SLM)
Detaillierte Informationen zu "Software-Lizenz-Management (SLM)": Getting Started
→   6

3.1.2  Benutzerrollen
Nach der Installation von FieldCare ist die Benutzeranmeldung zunächst deaktiviert,
so dass FieldCare ohne Login gestartet werden kann.

Benutzeranmeldung aktivieren
1. FieldCare Administrator öffnen →   14.

2.

User and User Groups → Configuration wählen und User Login active aktivieren.

Benutzerrollen
Verschiedene Benutzerrollen stehen zur Verfügung. Jeder Benutzer kann sich mit einer
bestimmten Rolle anmelden, die ihm zugewiesen ist. Er erhält die Berechtigung für
bestimmte Funktionen. Damit ist gewährleistet, dass ausschließlich berechtigte Personen
Zugang zu Technik und Betriebsfunktionen haben. Außerdem können die Rechte für eine
gewisse Zeit festgelegt werden.

• Beliebig viele Benutzer anlegen
• Optionale Einstellungen dem Benutzerkonto zuordnen
• Nach optionalen Einstellungen Passwort ändern
• Benutzer können Passwort ändern
• Benutzerpasswort ist für einen vorgegebenen Zeitraum gültig
• Benutzerkonto bei Bedarf deaktivieren
• Benutzer einer Rolle nach FDT-Standard zuordnen

Benutzerrolle Berechtigung

Administrator Alle Funktionen, wie z. B. Entwicklung, Inbetriebnahme und Laufzeitphasen in FieldCare
uneingeschränkt durchführen.

Administrativen Aufgaben, wie z. B. Benutzerkonten zuweisen.

DTM-Katalog ändern oder aktualisieren.

Planungsingenieur Alle Funktionen, wie z. B. Entwicklung, Inbetriebnahme und Laufzeitphasen in FieldCare
uneingeschränkt durchführen.

Wartungsingenieur Autorisierte Inbetriebnahme und Laufzeitphasen durchführen.

Geräte austauschen, kalibrieren und justieren.

Parameter auf die Geräte schreiben, ändern und lesen.

Gerätespezifische Operationen im Online-Modus durchführen.
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Benutzerrolle Berechtigung

Anwender Autorisierte Inbetriebnahme und Laufzeitphasen durchführen.

Aktueller Prozess beobachten und verwalten.

Aktuellen Status eines Geräts überprüfen.

Sollwerte ändern um ordnungsgemäßen Funktion des Gerätes zu gewährleisten.

Beobachter Aktueller Prozess beobachten und verwalten.

Geräteparameter und Dokumente von angeschlossenen Geräten lesen.

3.2  Anwendungsgebiet
FieldCare ist das universelle Tool, um intelligente Feldgeräte zu konfigurieren und zu ver-
walten. Einfache Gerätekonfiguration, Instandhaltungsmanagement, zustandsabhängige
Wartung und Plant Asset Management ist möglich. Je nach Lizenz kann es an unter-
schiedliche Bedürfnisse angepasst werden und ist somit jederzeit erweiterbar.
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4  Installation
Detaillierte Informationen zu "Installation": Getting Started →   6
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5  Bedienung

5.1  FieldCare starten
‣

FieldCare öffnen.
 FieldCare wird geöffnet.

5.2  Einstellungen in FieldCare vornehmen
1. FieldCare starten →   13.

2. Das Dialogfenster "FieldCare" schließen.
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3. Auf Extras → Options klicken.
 Das Dialogfenster "Options" wird geöffnet.

4. Anpassungen wie z.B. Sprache durchführen.

5. Änderungen mit OK speichern.

5.3  Einstellungen in FieldCare Administration
vornehmen

FieldCare vor dem Start von FieldCare Administration schließen.
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1.

FieldCare Administration öffnen.
 Das Dialogfenster "FieldCare Administrator Login" wird geöffnet.

2. Benutzername Administrator und Passwort Admin eingeben und auf Login klicken.
 Das Dialogfenster "FieldCare admin" wird geöffnet.

3. In der linken Spalte des Fensters das gewünschte Menü wie z.B. Users wählen.

4. Kontextmenü öffnen und gewünschte Einstellungen durchführen.

5. Änderungen speichern.
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5.4  Benutzeroberfläche

 1 Hauptdialog FieldCare

1 Anlagenansicht
2 Netzwerkansicht
3 Menüleiste
4 Werkzeugleiste
5 DTM/Parametersicht
6 Optionale Dialoge
7 Statuszeile

5.5  Allgemeine Einstellungen

5.5.1  Projekteinstellungen
1. In FieldCare auf Extras → Options klicken.

2. Auf die Registerkarte Project klicken.
 Die Registerkarte "Project" wird angezeigt.

3. Prompt for project at start-up wählen und auf OK klicken.
 Bei jedem Programmstart wird der Projektdialog angezeigt.



FieldCare SFE500 Bedienung

Endress+Hauser 17

5.5.2  Scaneinstellungen
1. In FieldCare auf Extras → Options klicken.

2. Auf die Registerkarte Scanning klicken.
 Die Registerkarte "Scanning" wird angezeigt.

3. Den Haken bei Connect after scanning if only one device is found and automati-
cally open the DTM in the Online window setzen und auf OK klicken.

Nach dem Erstellen des Netzwerks wird das Scanergebnis angezeigt.

Wenn FieldCare nach dem Scan nur ein Gerät findet, wird eine automatische Verbin-
dung mit dem DTM hergestellt und online geschaltet. Werden mehrere Geräte gefun-
den, muss jeder DTM einzeln verbunden werden. Je nach DTM führt ein Doppelklick
auf ein nicht verbundenes Gerät dazu, dass die Verbindung hergestellt wird. Ist dies
nicht der Fall, muss die Option Verbindungsaufbau verwendet werden. Die Konfigura-
tion einzelner Geräte wird in dieser Betriebsanleitung nicht beschrieben. Diese Infor-
mationen sind in der Betriebsanleitung des jeweiligen Gerätes zu finden.

FieldCare verwendet standardmäßig die FDT 1.2 Schnittstellen um einen Scan durch-
zuführen. Ist die Option "FDT 1.2.1 Scannen bevorzugen" aktiviert, können alternativ
die FDT 1.2.1 Scanoptionen verwendet werden.

FDT 1.2.1 kann beim Scan mit eigenem Comm-/Gateway DTMs Geschwindigkeitsvor-
teile bieten.

5.5.3  Anlagenansicht
Änderungen in der Netzwerkansicht werden automatisch mit der Anlagenansicht
synchronisiert. Manuelle Änderungen in der Anlagenansicht haben keine Auswirkun-
gen in der Netzwerkansicht. So ist es möglich unabhängig von einer Netzwerktopolo-
gie eine Anlage zu konzipieren.

Neue Ebene hinzufügen
1. Mit der rechte Maustaste auf einen Eintrag klicken.

2. Auf Plant View → Anlagenebene hinzufügen klicken.
 Neue Anlagenebene kann ausgewählt werden.
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 2 Struktur der Anlagensicht

Anlagenebene Beschreibung

Unternehmen Nur ein Eintrag dieses Typs in der obersten Ebene 0 anlegen.

Anlage
Bereich
Prozesszelle
Einheit

Auf Ebene 1 anlegen.

Bereich
Prozesszelle
Einheit

Unter dem Typ "Anlage" anlegen.

Prozesszelle
Einheit

Unter dem Typ "Bereich" anlegen.

Einheit Unter dem Typ "Prozesszelle" anlegen.

Analysemessgerät
Digitalmessgerät
Druckmessgerät
Spezialmessgerät
Durchflussmessgerät
Füllstandsmessgerät
Temperaturmessgerät
Ventil
Unbekanntes Gerät

Unter dem Typ "Einheit" anlegen

Position "Position" mit Position ändern nachträglich ändern.

 Bei allen anderen Typen ist dies nachträglich nicht mehr möglich. Hierzu muss
der Typ gelöscht und neu erstellt werden.

 Mit Zuweisen kann ein Eintrag mit einem Gerät der Netzwerkansicht logisch verknüpft werden. Mit
Zuweisen aufheben die Verknüpfung löschen.
Die Beschriftungstexte aller Einträge können nachträglich geändert werden.
Jeder Eintrag kann über das Kontextmenü mit einer Notiz versehen oder mit einer Datei oder URL einer
Webseite verknüpft werden.

Bevor die Anlagenansicht erstellt werden kann, muss die Netzwerkansicht erstellt sein. Die
Anlagenansicht entspricht der tatsächlichen Anlagentopologie, die technologische Sicht ist
eine hierarchische Darstellung des Produktionsprozesses. Jeder Nutzer mit einer Rolle "Pla-
nungsingenieur" oder höher kann die Anlagenansichten neu erstellen oder bereits beste-
hende Anlagensichten verändern.
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Die Positionen können in der Anlagenansicht verschoben werden. Die Elemente in der
Anlagenansicht können umbenannt, neu hinzugefügt oder gelöscht werden.

Spalte Verwendung

Plant TAG Anlagen-Tag für jede Anlagenposition.

Verbindungen Symbol das den Online/Offline-Status anzeigt.

Status Zeigt den aktuellen Diagnose Status an.

Überwacht Auswahl, ob das aktuelle Gerät über Condition Monitoring überwacht werden soll.

Kritisch Auswahl, ob das Gerät ein kritisches Gerät ist.

Kanal Gibt an, über welchen Kanal das Gerät verbunden ist.

Adresse Gibt die Adresse des Gerätes an, das dieser Anlagenposition zugeordnet ist.

Gerätetyp (DTM) Zeigt an, um welchen Gerätetyp es sich handelt.

Physikalisches Gerät Identifiziert das physikalische Gerät an der betreffenden Netzwerkstelle.

5.5.4  Netzwerkansicht
In der Netzwerkansicht ist die grafische Darstellung, zu einem FieldCare Projekt gehören-
den Gerätenetzwerk, zu sehen.

Spalte Verwendung

Netzwerk TAG Netzwerk-TAG des Gerätes.

Verbindungen Symbol das den Online-/Offline-Status anzeigt.

Kanal Zeigt an, über welchen Kanal das Gerät verbunden ist.

Adresse Eindeutige Netzwerkadresse des Gerätes.

Gerätetyp (DTM) Zeigt an, um welchen Typ es sich bei jedem der Geräte handelt.

Physikalisches Gerät Identifiziert das physikalische Gerät an der betreffenden Netzwerkstelle.

5.6  Generelle Funktionen
Anlagen-/Netzwerkansicht
• Über das Kontextmenü → Anlagenansicht anpassen
• Dialog anzeigen
• Spalten ein- und ausblenden
• Reihenfolge der Spalten anpassen

Listenfunktion
• Sortierung der Listen über Titelzeile einer Spalte anpassen
• Spaltenbreite anpassen
• Spaltenreihenfolge mit "Kopieren" und "Ersetzen" ändern

5.7  Netzwerk überprüfen
Die Netzwerktopologie in FieldCare kann mit dem tatsächlichen physikalischen Netzwerk
verglichen werden. Dies ist besonders nützlich, wenn ein Gerät an ein bestehendes Netz-
werk hinzugefügt wird. Es kann ein Projekt im offline Modus vorbereitet und anschließend
über FieldCare hochgeladen werden. Dadurch kann die bestehende Topologie im Netzwerk
und die physischen Topologie überprüft werden, um notwendige Änderungen vorzuneh-
men.

Vor dem Überprüfen des Netzwerks muss beachtet werden, dass nur verifizierte Netz-
werke für Kommunikationsgeräte überprüft werden, die zumindest einen DTM unter
sich haben. Andernfalls wird der Menüpunkt Netzwerk verifizieren deaktiviert.
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Netzwerk überprüfen
1. In der Netzwerkansicht ein Gerät mit mindestens einem DTM unter sich, auswählen.

2. In der Werkzeugleiste auf Netzwerk verifizieren  klicken.
 Das Dialogfenster "Kommunikationskanal" öffnet sich.

3. Den gewünschten Kanal auswählen und auf OK klicken.
 FieldCare scannt den gewünschten Kanal.

Nach der Überprüfung des Netzwerks öffnet sich das Dialogfenster "Scanergeb-
nis".
Es wird eine Geräteliste angezeigt und die Spalte Status gibt Informationen darü-
ber, wie gut sich die Geräte der vorgeplanten in die tatsächliche Topologie einpla-
nen lassen.
Insgesamt gibt es fünf verschiedene Zustände:
Gerätetypen und Seriennummer sind identisch.
Gerätetypen sind identisch.
Gerätetypen sind unterschiedlich.
Neues Gerät gefunden.
Gerät unerwartet im Projekt.

4. Im Kontextmenü des jeweiligen Geräts können Änderungen vorgenommen werden.
Gerätedaten lesen, schreiben oder Gerätetyp ersetzten.
Änderungen vornehmen und OK klicken.
 Änderungen werden gespeichert.
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6  Systemintegration

6.1  IP-Adresse einrichten
• Administratorrechte sind erforderlich
• Beschreibung gilt für Windows 7

Endress+Hauser Geräte mit einer Ethernet-Schnittstelle werden mit einer
IP-Standardadresse ausgeliefert, z. B. für Fieldgate FXA720 die IP-Adresse ist
192.168.253.1. Damit der Hostcomputer mit dem Fieldgate FXA720 Webserver kommu-
nizieren kann, muss ihm eine IP-Adresse in derselben Adressdomäne zugewiesen werden,
z. B. 192.168.253.99. Für mehr Informationen an den Netzwerkadministrator wenden.

IP-Adresse des Computers einrichten
1. Auf Start → Systemsteuerung → Netzwerk und Internet → Netzwerk- und Freiga-

becenter klicken.
 Das Dialogfenster "Netzwerkverbindungen" öffnet sich.

2. Auf Netzwerkverbindungen verwalten klicken.

3. Mit der rechten Maustaste auf die Verbindungen klicken, die geändert werden sol-
len.

4. Bei Aufforderung:
Administratorkennwort oder Bestätigung eingeben.

5. Mit der rechten Maustaste auf die Registerkarte Netzwerk klicken.

6. Unter dem Eintrag "Diese Verbindung verwendet folgende Elemente" auf Internet-
protokoll Version 4 (TCP/IPv4) klicken.

7. Auf Eigenschaften klicken.

8. Ursprünglichen Werte für IP-Adresse und Subnet-Maske des Computers notieren,
um sie am Ende des Vorgangs bei Bedarf wiederherzustellen. Ein in einem Firmen-
netzwerk verwendeter Computer bezieht seine Adresse automatisch.
Auf Folgende IP-Adressen verwenden klicken.

9. IP-Adresse, Subnetmask und Standardgateway bei "TCP/IPv4" eingeben.
 Einstellungen für die IP-Adresse werden übernommen.

10. Auf OK klicken.
 Vorgang wird abgeschlossen.

6.2  Windows-Firewall
Wenn auf den Computern, auf denen sich die Server und Clients befinden, Firewalls
verwendet werden, müssen diese so programmiert werden, dass Server und Clients
gegenseitig aufeinander zugreifen können. Die Konfiguration einer Firewall ist häufig
ein Element der IT-Sicherheitsstrategie eines Unternehmens. Daher sollte der
Systemadministrator konsultiert werden, bevor fortgefahren werden kann. Außerdem
sind für diese Aufgabe Administratorrechte erforderlich.

Die für Fieldgate SFG500 verfügbaren Ports werden in der nachstehenden Tabelle aufge-
führt:

Portnummer ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Windows-Firewall verwalten
1. Auf Start → Systemsteuerung → Windows-Firewall klicken.

2. Auf Programm durch die Windows-Firewall lassen im linken Bereich klicken.

3. Bei Aufforderung:
Administratorkennwort eingeben.

4. Den Haken bei dem Programm setzen, das zugelassen werden soll, und auf OK kli-
cken.

5. Auf Erweiterte Einstellungen im linken Bereich klicken.

6. Bei Aufforderung:
Administratorkennwort eingeben.

7. Im Dialogfenster "Windows-Firewall mit erweiterter Sicherheit" auf Eingehende
Regeln klicken.

8. Auf Neue Regeln im linken Bereich klicken.

9. Den Anweisungen im Assistenten für neue eingehende Regeln folgen.

10. Auf Registerkarte Ausnahmen wechseln.
 Zwei Hauptebenen öffnen sich auf diesen können Ausnahmen hinzugefügt wer-

den.
"Programm hinzufügen" gibt an, welche Anwendungen auf unaufgeforderte
Anfragen reagieren können.
"Port hinzufügen" gibt an, dass die Firewall TCP-Verkehr von den Servern verwen-
deten Ports zulassen soll.

11. Auf Registerkarte "Allgemein" das Kontrollkästchen An (empfohlen) aktivieren.

Firewall ist jetzt aktiv.
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7  Betrieb
Die projektbezogenen Daten werden abhängig vom Projektspeichermodus in eine Daten-
bank oder in Dateien abgelegt.

7.1  Bediensprache einstellen
1. FieldCare öffnen.

2. Extras → Options auswählen.
 Das Dialogfenster "Options" wird geöffnet.

3. In der Registerkarte Display die Sprache wählen und auf OK klicken.
 Die Sprache ist gespeichert und nach dem nächsten Programmstart verfügbar.

7.2  Projekt erstellen
Die ersten Schritte für das Erstellen eines Projekts sind immer identisch. Standardmä-
ßig wird das Dialogfenster FieldCare angezeigt, das Sie unter Extras → Options →
Project deaktivieren können. Ist das Kontrollkästchen None aktiviert, wird das Field-
Care Dialogfenster nicht angezeigt.
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Projekt erstellen
1. FieldCare öffnen.

 Das Dialogfenster "FieldCare" wird geöffnet.

2. In der Registerkarte "New" den Eintrag Create Project wählen und auf Open klicken.
 FieldCare öffnet ein neues Projekt mit einem "Host-PC".

7.3  Projekt speichern
FieldCare Projekte werden in einer Datenbank gespeichert. Auf die Projekte kann
jedoch nicht in Form von Dateien auf der Festplatte zugegriffen werden. Ein Zugriff
auf die Dateien ist möglich, wenn FieldCare im Dateimodus verwendet wird. Alle Pro-
jekte werden auf dieselbe Weise gespeichert.

Projekt speichern
1. File → Save As auswählen.

 Das Dialogfenster Save Project As wird geöffnet.

2. Projektnamen eingeben und auf Save klicken.
 Projekt wird gespeichert.
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7.4  Gespeichertes Projekt öffnen
Gespeichertes Projekt öffnen
1. Im Dialogfenster FieldCare auf die Registerkarte Existing klicken.

 Das Dialogfenster "Open Project" mit den zuletzt geöffneten Projekten wird ange-
zeigt.

2. Gewünschtes Projekt wählen und auf Open klicken.
 Projekt wird angezeigt.

Wenn das Projekt nicht auf dem Bildschirm angezeigt wird, auf View → Network kli-
cken.

7.5  CSV Ex- und Import
Die Strukturinformation der Anlage und Netzwerkansicht (Anlage/Netzwerktopologie)
kann in eine CSV exportiert und von einer CSV-Datei in ein FieldCare Projekt importiert
werden.

CSV-Datei importieren
1. Projekt erstellen. →   23

2. Auf Datei → Importieren/Exportieren → Importiere CSV-Datei klicken.
 Das Dialogfenster "Importiere CSV-Datei" öffnet sich.

3. Eine Datei auswählen und auf Öffnen klicken.
 Die Daten der CSV-Datei werden in die Anlagenansicht und/oder Netzwerkan-

sicht importiert.

CSV-Datei exportieren
1. Projekt auswählen.

2. Auf Datei → Importieren/Exportieren → Exportiere CSV-Datei klicken.
 Das Dialogfenster "Exportiere Topologie" öffnet sich.

3. Auf Export klicken.

4. Einen Speicherort und Namen auswählen und auf Speichern klicken.
 Die Netzwerkansicht wird in eine CSV-Datei exportiert.
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7.6  DTM-Informationen
Das Dialogfenster Information enthält eine Zusammenfassung aller relevanten DTM-
Informationen.

DTM-Informationen anzeigen
1. In der Menüleiste auf Device Catalog klicken.

2. Auf View klicken.
 Der Geräte-Katalog wird geöffnet.

3. Mit der rechten Maustaste auf ein DTM klicken.

4. Auf DTM Information klicken.
 Das Dialogfenster "Information" wird geöffnet.

Mögliche Optionen im Dialogfenster "Information"
• Zeigt Basisinformationen aller Gerätetypen die DTM unterstützt
• Zeigt Informationen zu dem DTM:

• Manufacturer Id
• Device Type Id
• SubdeviceType Id
• Device Type Information

7.7  Geräte-Katalog anzeigen
Das Dialogfenster Geräte-Katalog enthält die Liste sämtlicher DTMs und FDI Packages,
die sich momentan in dem Gerätemanagementsystem befinden. Wahlweise ist eine Grup-
pierung nach Kategorie, Hersteller oder Protokoll möglich.

1. In der Menüleiste auf Geräte-Katalog klicken.

2. Auf Anzeigen klicken.
 Der Geräte-Katalog öffnet sich.

7.8  Geräte-Katalog aktualisieren
Detaillierte Informationen zu Geräte-Katalog aktualisieren: Getting Started →   6



FieldCare SFE500 Diagnose und Störungsbehebung

Endress+Hauser 27

8  Diagnose und Störungsbehebung

8.1  Allgemeine Störungsbehebung

Störung Störungsbehebung

FieldCare SQL Server
startet nicht.

Den SQL Server manuell starten:
• Windows starten und in das Suchfeld services.msc eingeben.
• SQL Server (SQLFIELDCARE) auswählen.
• Auf Start klicken.

Fehlende Scanning
Makros.

Makros importieren:
• Im Ordner "...\Endress+Hauser\FieldCare\db" die Datei ImportScanningMacros.cmd

importieren.
• Anschließend FieldCare neu starten.

Doppelte Menü Ein-
träge oder fehlende
Fenster.

Layout resetten:
• FieldCare schließen.
• Im Ordner "...\Endress+Hauser\FieldCare\Profiles" die Datei profile.xml löschen.

Fehlerhafter Geräte-
Katalog.

FieldCare Geräte-Katalog zurücksetzen:
• FieldCare schließen.
• Im Ordner "...\Endress+Hauser\FieldCare\Frame" die Datei FRMRepository.xml

löschen.
• FieldCare neu starten und den Geräte-Katalog aktualisieren.

Bei weiteren Störungen wenden Sie sich bitte an Ihre Endress+Hauser
Vertriebszentrale: www.addresses.endress.com
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9  Software Updates
Detaillierte Informationen zu "Software aktualisieren": Getting Started →   6









www.addresses.endress.com

*71638161*
71638161
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